P ARC File Organization Guidelines

Summary

Save your files within a folder called Projects. Arrange your project files in a clean, organized,
and logical fashion. Make it easy for your fellow team members to find and understand your

work.

Standard Folders

Revised 2015-06-18

The root directory of an ARC workstation typically contains the following notable folders:

& Applications
@ Library
M Projects
M Proposals
@ System
@ Users:
& AccountName:
i Public:
s Drop Box
s Desktop
M Downloads

Project Organization

The Projects folder is the central location in which your work files reside. Inside, create
subfolders for each of your active projects. Name each of these project folders with a pre-

assigned numeric code and descriptive title.

Refer to your project manager, office manager, or the
ARC Time Sheets web application! for a list of active
project numbers.

! https://www.arcoffice.com

Enter a Project Number:

21319.1330 :
21319.1320 :
21319.1310:
21318.1530:
21318.1520 :

LCPS: Special Planning Tasks

LCPS: GIS Assistance

LCPS: FMP Annual Update

Santa Fe County FCA Web Application Maintenance
Santa Fe County FCA Parks and Open Space



https://www.arcoffice.com

Examples of individual project folder names:

M 21416.0000 UNM-G Campus FMP Update
m 21506.0000 NMSU Carlsbad Early Childhood Center
m 98000.4000 Research and Development

The Proposals folder contains material for work bids and marketing resources. Each subfolder
within Proposals should contain the solicited entity’s name and the four-digit year of the
submission.

Proposals don’t have a unique identifier code. But they could be considered to be part of “98000.100 -
Administrative - Marketing.”

Examples of individual proposal folder names:

I Colfax County CP 2014
® Taos Pueblo Planning 2012
m Roswell PS FMP 2015

Project Subfolders

Store project documents inside their designated project directory. Ideally, a project folder
should be a self-contained root entity with no external dependancies. It may be helpful to
group files by category, such as all image files grouped within “Graphics” and all Excel
workbooks in “Spreadsheets.” Some examples of project subfolders appear below:

I Projects:
M 21416.0000 UNM-G Campus FMP Update:

M Graphics
M InDesign
m RFP
I Notes
m PDFs
M Reference
M Correspondence
M Spreadsheets

You can also use a Spotlight search query? as a non-hierarchal meta-folder. This
approach lets you view disparate documents in a convenient, consolidated location.

2 https://en.wikipedia.org/wiki/Spotlight (software)
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In the example below, “InDesign Saved Search Query” is a virtual folder that contains
recently-modified report files scattered across various locations:

>
>
[ City of Lovington Comp Plan Proposal 2014  »
[ City of Socorro Proposal Cover 2014 >
[ Cloudcroft Comp Plan Cover 3
|71 Clovis Municipal Schools RFQ 2011 3
[7] CNM Proposal 2010 3
[ Colfax County 2014 3
[ Columbus 2011 3

=N " s -

NN [T} InDesign Saved Search Query

[ Central Consolidated School District 2015 » |% CES proposal cover info.txt '. Brochure Tri-Fold v0.indd
[ CES Proposal 2009 » = CES RFP 2011-006.pdf '. Brochure Tri-Fold v1.indd
|| CES Proposal 2011 » |71 Exports > '. Brochure Tri-Fold v2.indd
|71 CES Proposal 2013 [ Niustrator » Il Brochure Tri-Fold v3.indd
[ CES RFP 2015 [ InDesign » “Jl Brochure Tri-Fold v4.indd

¥ InDesign Saved Search Query '. Brochure Tri-Fold v5.indd

@ Brochure Tri-Fold v6.indd
A Brochure Tri-Fold v7.indd
'. Brochure Tri-Fold v8.indd
Al Building_802v4.indd
Al Building_802v4.indd

'. CCSD Proposal Covers.indd
P -

A Spotlight search query displays its results instantly and remains “live,” revealing new
content as conditions change. Spotlight searches can have elaborate criteria that govern

their contents:

Content Creator a begins with a Adobe lllustrator
All E of the following are true:
Content Modified E within last E 8 years

Locations

Local volumes + user home

Exclude: /Applications

Exclude: = ~/Library/Application Support

Exclude: = ~/Library/Mail

Exclude: = ~/OneDrive

Limit

10,000 B most E recently modified

Refine
Any Text a contains words B
Any a of the following are true:
Content Type a is a com.adobe.illustrator.ai-image a
Kind E is E Affinity Designer a
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®00 21 New Project
Applications like Apple Xcode? and Side Otters_of Ottoa
Effects Houdini* can generate a new project /Projects/98000.400 Research ) [}
hierarchy with various subfolders
automatically. Another approach is to clone an
existing folder template populated with
common subfolders and empty support files.

Other applications like Adobe InDesign can

assist with organization by consolidating all

referenced links and support files into a new
subfolder with a File > Package command.

1
g

File Names

Name your files with concise, descriptives titles that denote their content. Use capitalization
and punctuation where appropriate. Use a readable and consistent naming convention for
each file and avoid producing a jumble of indecipherable characters.’

Examples of Good Titles

“Title Case Format with Whitespace v1.ext”
“CamelCaseFormatv2.ext”

“snake case format v3.ext”
“spinal-case-format-v4.ext”

“all lower case 2016 v5.ext”

“Final Report March 1999 v2.doc”

Examples of Poor Titles

“SCREAMINGCASEFORMATV1.EXT”
“Documentl.doc.docx.ext”
“UNTITLED1 repport+final 3/99 (2) revl10 PDD.ext”

File Extensions

Most applications automatically append a suffix to a file’s name, indicating the type of data
it contains. Primitive computing platforms® rely exclusively on fragile file extensions to
determine file type, but modern systems employ smarter, more reliable methods.”

3 Application Development Tools - https://developer.apple.com/xcode,

43D Graphics Software - https://en.wikipedia.org/wiki/Houdini (software)

5 Purdue Data Management - http://guides.lib.purdue.edu/content.php?

id=440001&sid=4901667

6 DOS Short File Name - https://en.wikipedia.org/wiki/8.3_filename

7 Intelligent Data Type Classification - https://en.wikipedia.org/wiki/Uniform Type Identifier
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Unique File Names

Use unique file names in each folder. Most operating systems forbid name collisions,® in
which two different files in the same directory share the same name. If such a conflict
arises, the computer will either forcibly rename the offending files, or simply overwrite one
of them. In either case, you could lose data.

Digital cameras tend to produce images with oo

forgettable names like “DSCF2032.jpg.” Replace Toxt [

Take advantage of your computer’s Find: | DSCF Replace with: | Chama ES Site
automation features to assign meaningful Examplo: Chama ES Site 2006 pg Cancel | | Rename

file names to a batch of files at once.

@) Forbidden Characters

OS X has few restrictions of the characters allowed in a file name. But
avoid colons (“:”) and forward slashes (“/”), which the system reserves
as path separator identifiers.” Microsoft Windows forbids many
common characters including the asterisk (“*”), question mark (“?”),
quotation marks (“"'”), angle brackets (“<”, “>"), and pipe (“|”).
Word dividers like interpunct “.” and space “ ” are usually fine, but can

be problematic when transferred externally.

€«

Le Mew ® .3dm

The computer will complain if it encounters a name it deems unsuitable.

< | Windows

Computer  View

The name “C:\NGRTLNS.W95?” can’t be
used.

-‘L Try using a name with fewer characters, or with no 2
punctuation marks. E

-

v 1 85 Windows Search Windows

Names that begin with a dot “."” are reserved

! B for the system.

If you decide to go ahead and use a name which
begins with a dot the file will be hidden.

|C:\NGRTLNS.W95?

litem 1i

A file name can't contain any of the following characters:

Cancel | LN VAT

8 https://en.wikipedia.org/wiki/Name collision
9 https://en.wikipedia.org/wiki/Path (computing)
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Versioning

Save iterations of your files. Before making
major changes to a document, duplicate it and
append a new version number to the end of its
name.!°

Example of a file iteration sequence:

)

“West Capitol Campus Conceptual Map v1.ai’
“West Capitol Campus Conceptual Map v2.ai”
“West Capitol Campus Conceptual Map v3.ai”

You may need to further distinguish a file
version with your initials or a date stamp:

“West Capitol Campus Map for Print v3.ai”

If tacking data onto a file’s name becomes
cumbersome, try adding that information to the
file’s comment field.!! You can reveal this
information panel by selecting a document in the
Finder and choosing File > Get Info:

00 [ Report lterations

Search for: Q

Name Size
‘ Los Alamos FMP Update 2014 v0.indd 9.8 MB
‘ Los Alamos FMP Update 2014 v3.indd 17.5 MB
i Los Alamos FMP Update 2014 v4.indd 15.5 MB
i Los Alamos FMP Update 2014 v5.indd 15.9 MB
‘ Los Alamos FMP Update 2014 v6.indd 28.7 MB
i Los Alamos FMP Update 2014 v7.indd 57.6 MB
i Los Alamos FMP Update 2014 v8a.indd 49.9 MB
‘ Los Alamos FMP Update 2014 v8b.indd 49.9 MB
‘ Los Alamos FMP Update 2014 v8c.indd 50 MB
i Los Alamos FMP Update 2014 v9.indd 63.7 MB
‘ Los Alamos FMP Update 2014 v11.indd 61.1 MB
‘ Los Alamos FMP Update 2014 v12.indd 61.3 MB
i Los Alamos FMP Update 2014 v14.indd 66.2 MB
i Los Alamos FMP Update 2014 v15.indd 68.8 MB

® ® @ (g Black Metal Color Swatches.lib Info [ X N
=¢| Black Metal Color Swatches.lib 1.9 MB

q-

ol =y v @& @

Modified: Today, 4:58 PM

Name Comments
@J Black Metal Color Swatches.lib Contains plotter colors.
P General: i Generic CD Label Stickers.ai Contains a badger-like mammal.
» More Info: %
» Name & Extension: < Animals Clip Package Contains two goats and a platypus.

¥ Comments:

Contains plotter colors.

Text added to this field is visible within the Comments column header in each Finder

window.

10 Revision Control Systems - https://en.wikipedia.org/wiki/Versioning file system

11 Version Control Guidelines - http://nidcr.nih.gov/Research/ToolsforResearchers/Toolkit/VersionControlGuidelines.htm
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Many applications encourage you to attach metadata!? directly to open documents.
Metadata can include user-defined details like authorship, copyright terms, and search tags.
This contextual information is visible in the Finder, Spotlight searches, and Unix command
line!® utilities.

Q. "Let all your things have their places" - rie ogenzatoncu 52

TOP HIT Topic
v - . .
R File Organization Guidelines.o03 ARC File Organization
Revised 2015-06-17
‘: Show all in Finder... These guidelines primarily refer to Apple’s desktop computing platform *OS X,~ but apply to other erf
GNOME.
o Document Q00 [#] Searching “This Mac”

[m D % 1 of 1 selected

Search for: | Q "Let all your things have their places”

File ® Compress on disk Search: Spotlight Meta... Shared | Save -
Copyright: 2015 — S

Version: |01 E File Organization Guidelines.oo3 OmniOutliner 3
Subject: ARC File Management

Description: Organization Guidelines

Comments:
Let all your things have their places;
let each part of your business have its DB » [ File Orga: » File Organization Guidelines.o03
time.
00 |* File Metadata Command Line.worksheet

mdls -name kMDItemComment -raw

Projects B "File Organization Guidelines.oo3"

98000.000 Administrative
98000.400 - Research

Let all your things have their
places; let each part of your
business have its time.

Line 3 Col 85 zsh Unix Shell Script 5 |7 151 /...

12 http://arstechnica.com/apple/2001/08/metadata,

en.wikipedia.org/wiki/Command-line_interface
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Some applications offer their own internal version history!* mechanism. While helpful, this
feature is not a substitute for proper file-level document management.

New 3N
Resource Browser {+3N
Open... 380

Open Recent

Close

Save 3#8S
Duplicate {3#S
Rename...
Move To...
Export... X #E

Save As Template...
Revert To

Page Setup... ¢ ¥#P
Print...

Data Security

Password-protected Disk Images

IFiIe Edit Format View Organize Window Help

Last Saved — Today, 11:28 AM
Last Opened — Today, 11:41 AM
Browse All Versions...

A disk image (with a “.dmg” or
“.sparsebundle” file suffix) is a portable
data file that behaves like a virtual hard
disk. When unmounted, its contents
are locked and inaccessible. Some of
ARC’s projects require high-level
security protocols, and an encrypted
disk image is an effective way too ensure
your sensitive data remains private. You
can use Apple’s Disk Utility to create an

Save As: Admin Encrypted Disk Image.dmg v
Tags:
Where: [ 98000.000 - Administrative d

Name: Admin Encrypted Disk Image.dmg

Size: 500 MB

Format: Mac OS Extended (Journaled)

Encryption | 256-bit AES encryption (more secure, but slower)

Partitions: = Hard disk

Image Format: read/write disk image

Cancel

ofof ol of o

encrypted disk image.

14 OS X Lion: About Auto Save and Versions - https://support.apple.com

en-us/HT202255
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Full Disk Encryption

Another method of protecting data from unauthorized access is to encrypt the entire hard
disk!®> using a built-in system service. Examples include Apple FileVault,'® Microsoft
Bitlocker,'” and dm-crypt!8 for Linux.

o0 < i Security & Privacy Q

General Firewall  Privacy

FileVault secures the data on your disk by Turn On FileVault...

Y _ encrypting its contents automatically.
n WARNING: You will need your login password or a recovery key to access your data. A

recovery key is automatically generated as part of this setup. If you forget both your
password and recovery key, the data will be lost.

SN

(€) i Create a Windows To Go workspace

Set a BitLocker password (optional)

A BitLocker password encrypts your Windows To Go workspace. You'll need to enter the password every
time you use your workspace. This is different from the password you use to sign in to your PC.

[ ] Use BitLocker with my Windows To Go workspace

Enter your BitLocker password:

Reenter your BitLocker password:

Show my password

Cancel

15 https://en.wikipedia.org/wiki/Disk_encryption#Full_disk_encryption
16 https://support.apple.com/en-us/HT204837

17 https://en.wikipedia.org/wiki/BitLocker

18 https://en.wikipedia.org/wiki/Dm-crypt
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User Folders

Desktop

The Desktop is the background area of the file browser, usually adorned with a
wallpaper image or color tone. Use this area sparingly for temporary files.!® Don’t
store project folders, files, or applications here. A more efficient way to quickly access
your data is with Finder sidebar favorites, Dock shortcuts, and instant search utilities
like Spotlight or LaunchBar.?°

@ Finder File Edit View Go Window Help = 3 G309 = Mon355PM (3

Public > Drop Box

One of the default file sharing locations on OS X is called “Drop Box,” and resides in

the “Public” directory of your home folder. This folder has no relation to the popular
commercial file synchronization service called “Dropbox.2!” If you receive a new item
in this location, remember to move it into an appropriate project folder.

19 An Overly Cluttered Desktop Can Seriously Slow Down Your Mac - http://lifehacker.com/5893054
20 Instantaneous Launching Utility - https://en.wikipedia.org/wiki/LaunchBar
21 Cloud Storage Service - https://www.dropbox.com
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Downloads

Files that you obtain through a web browser or email program usually end up in the
Downloads folder in your home directory. Try to keep this location clean by
periodically discarding outdated files.

Library

The hidden user library folder contains application settings and system configuration
files. You’ll generally have no need to modify its contents, but if you’d like to peek
inside, hold down the Option key and choose Go > Library in the Finder.

Email

Try not to store email messages indefinitely inside your inbox. After reading a new message,
either file it away or delete it.22 Don’t force yourself to constantly sift through all those
distracting old messages.?3

Some users create dedicated email folders corresponding with each active project, and store all
related incoming and outgoing messages there. Others rely on dynamic searches and smart
folders to keep relevant communications together. It can also be helpful to export an archive
of a project’s messages as a read-only copy for later reference.

When composing a new message, indicate its project (name, number, or other identifier) in
the subject line as a courtesy to your recipient.

File Servers

ARC workstations can connect to various local network hosts to share project data. One such
network host is called “ARC Server,” and contains a share point nicknamed “ARC Drop Box.”
This network volume should adhere to the same directory hierarchy as any other project
folder, and is subject to periodic administrative reorganization.

When adding a new file to a server directory, also keep a copy on your local machine. If a
network outage or server disruption occurs, you would still have access to your work data.
Likewise, before editing a document that resides on a remote server, copy it to your local
machine. If a network disruption struck in mid-edit, your data could become corrupted.
Working from your local hard disk is faster, and allows your computer’s built-in backup
services to better protect your data.

22 http://xph.us/2013/01/22/inbox-zero-for-life.html
23 http://zenhabits.net/email-zen-clear-out-your-inbox/
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Network Guest Access

You can view a list of available servers within a directory called “Network” in your file
manager. Most workstations grant limited access permissions to unauthenticated guest

connections.

Network

Network

Name
E&— Mac 26 (File Sharing)

E&— Mac 26 (Remote Login)

&— Mac28

&= Mac 31 (File Sharing)

&— Mac 31 (Remote Login)

&= Mac 35 (File Sharing)

&— Mac 35 (Remote Login)

.' windows Network

Network Registered User Access

- e

Enter your name and password for the server
“Mac 65”.

Connect as: ) Guest

Registered User
Using an Apple ID

Cancel

Many workstations require authentication before you can access them. The standards and
procedures for ARC usernames and passwords are inconsistent. So at the moment, it’s
best to ask an office manager or IT manager for help with a connection.

Commercial Synchronization Services

Online network file services like Dropbox, Microsoft OneDrive, and Apple iCloud have their
own idiosyncrasies about file organization. For example, Dropbox places its synchronization
directory in your home folder by default. In order to keep your documents synchronized
between devices, you may need to migrate active project folders to this alternative location.

Some services like Microsoft OneDrive offer granular control, allowing you to exclude certain

subfolders altogether.

Choose Folders

You can use symbolic links and aliases?* to make a ) a

folder appear to exist in more than one location
simultaneously. For example, you can store a folder in

Choose Folders About

Sync only what you want

If you don't want to download everything on your OneDrive to this Mac,

Dropbox’s default location, then drag an alias to your e

Projects folder. The folder’s content remains accessible

(‘ © All files and folders on my OneDrive

from either 10C3.ti01’1, Yet consumes no additional Everything but files shared with you will sync on this Mac.

storage space.

rﬁ Choose folders to sync

24 http://macs.about.com/od/faql/f/What-Are-Aliases-Symbolic-Links-And-Hard-Links-In-Mac-Os-X.htm
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Conclusion

Keep your work files organized in a centralized location named Projects. Store related files
together, use descriptive file names, and preserve iterations of each file as your project evolves.
Don’t store files permanently on the Desktop.

File Management Software

A file manager is a software application devoted to organizing and managing files and folders.
Some examples appear below.

Apple Finder
https://en.wikipedia.org/wiki/Finder_(software)

00 [ InDesign

7 19750 GNP CSP |7 Client comments > ‘. DACC_MP5_AppendixV7.indd
] 21109 Lea County Courthouse =» DACC 2014 v1 home.pdf ‘. DACC_MP5_AppendixV8.indd
7 21111 San Juan JC ® ‘ DACC_MP5_Overview.v1.indd '. DACC_MP5_AppendixV9.indd
|1 21221 DACC Update 2014 |71 Document fonts > ‘ DACC_MP5_Overview.v0.indd
| ] 21223.4010 AP...A EdSpec 2014 |7 graphics > ‘. DACC_MP5_Overview.v2.indd
|71 21223.4020 APS FMP update || InDesign > '. DACC_MP5_Overview.v3.indd
[ 21228 Moriarity FMP Update 2014 # Instructions.txt l DACC_MP5_Overview.v4.indd
[ 21302 Springer FMP {7 PDFs * i DACC_MP5_Overview.v5.indd

7] 21304 Des Moines

| 7] 21308 Taos Efficiency

|71 21309 Taos Pueblo

7 21311 santo domingo

|71 21312 Harding County

(0] 21313.1310 San Miguel County
| 7] 21314 Cloudcroft CP 2014

Tl DACC_MP5_OverviewV6.indd
il DACC_MP5_OverviewV7.indd
Tl DACC_MP5_OverviewVs.indd
il DACC_MP5_OverviewVa.indd
Al DACC_MP5_OverviewV10.indd
_MP5_OverviewV11.indd

¥V VV VvV VYV VYV VYV VVYVYVYVYY

Cocoatech Path Finder

http://www.cocoatech.com/pathfinder/

o000 [19 Architectural
@ ’ UserData » Library » AppSupport » Luxol » C 01 » Assets » Meshes » Interior Windows » Preview ~
Assets Meshes Interior Architectural 15t 161)
> Scenes > Exterior > Window Treatment » Windows
> Profiles > Electronic Devices » Tabletop > Sinks
> Meshes > Basic > Household Items > Floor
> Matcaps (3 Animals > Decorativ...cessories » Doors
Images > Toon S Appliances > Cabinets
Colors > Creatures > . Architectural > Bathroom
Brushes > Interior > Furniture > Lights
P <y .
7 items, 1.9 TB available Architectural
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Microsoft File Explorer

https://en.wikipedia.org/wiki/File_Explorer

<

&«

| 5 | Notes

Home Share View

v <« Documents > Notes v O Search Notes

] Name

[ Blank.jtp

(V16 Dotted Line jtp

1

items

|t Genko 1.jtp

@ Genko 2.jtp

@] Graph.jtp

@ Memo.jtp

[Eljl Month Calendar.jtp
@ Music.jtp

@ Seyes.jtp

@ ShortHand.jtp

[l To Do Listjtp

>
1 item selected 11.2 KB

Dotted Line,jtp

Journal Template

Date modified: 4/24/2015 9:43 PM
Size: 11.2KB

Date created: ~ 5/19/2015 2:17 PM
Availability: Available offline

Haiku Tracker

http://www.haiku-os.org

. | SMP RFP 2016

|

File Window Attributes d

IvName [ Kind A

J Graphics Folder —
J InDesign Folder
J Notes Folder
J PDFs Folder
J Reference Folder
J RFP Folder

J Spreadsheets Folder —

7 items < >/ [ [¢]>] .::
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Panic Transmit
http://panic.com/transmit-ios/

upload-unedited

New Item
Image-URLs.txt

New File...
g5 index.html

New Folder...

Import from iCloud Drive...

Image-URLs.txt .

A Take Photo or Video

e Photo Library
Image-URLs.txt
Today, 1:51 PM

Today, 12:10 PM

Permissions R=P—=F—

Other Useful File Resources

Objective Development LaunchBar
https://www.obdev.at/products/launchbar/

Houdah Software HoudahSpot
http://www.houdah.com

TLA DragThing
http://dragthing.com

Zardetto, Sharon Take Control of Spotlight for Finding Anything on Your Mac
http://www.takecontrolbooks.com/spotlight

McElhearn, Kirk Take Control of LaunchBar
http://www.takecontrolbooks.com/launchbar
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